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1. Software introduction  

Cube-3d is a mapping and aerial image processing software solution. It lets you build professional 3D models from 2D 

images and geospatial data, captured using drones or other vessels and devices. Cube-3d offers photogrammetric 

processing (building geometry, geo-referencing, dense reconstruction) as well as 3D modelling and analysis of both Cube-

3d-generated photogrammetric point clouds and third -party source data (las, LiDAR, CAD, etc). Create your own 

orthophotos (DOF), digital surface models (DSM) or calculate volumes and manage stockpiles in a fast and easy manner. 

An integrated reports wizard will help you put all that work together in a compact and presentable way.  

Type of accessible data differs from project to project as should workflow. Two most popular use cases: 

1. Drone flight & Mission Planner + Cube -3d Processing + Cube-3d Modelling and Analysis 

Capture your own images (along with EXIF, GNSS, GPS RTK, etc. data for geo-referencing) and import them to Cube -3d for 

photogrammetric processing.  Set parameters for bundle adjustment, orientation (geo -referencing) and reconstruction.  

The result will be a metric, geo-referenced, realistically coloured 3D point cloud that serves as a basis for all further 

calculation, modelling and analysis. Learn more about project preparation or jump to  License details . 

2. Cube-3d Modelling and Analysis 

Just finished with Processing? Importing third -party data, such as las point clouds, photogrammetric point clouds from 

other sources, LiDAR, etc. without having your own data for photogrammetric processing? No problem. This part lets you 

build, manipulate and customize point clouds, DSMs, DEMs, orthophotos, calculate volumes and profiles, contour lines, 

generate reports and export data in various formats for further CAD or any other use. Go to Modelling & Analysis.  

This manual will help you get the most out of Cube-3d to achieve high-accuracy, survey-grade results in a professional and 

high-tech approach. Naturally, being a team of surveying professionals, we made sure that Cube-3d also supports data 

acquired with classical measuring methods and devices. 

 

1.1. System requirements 

Cube-3d runs on Windows 64-bit operating system. Processing runs on CPU, graphical interface runs on GPU. For best 

performance and speed make sure you have enough RAM (16GB+). See below for further specification requirements. 

 

Minimum  

Windows 7, 8, 10; 64 bit, Intel i5 or Ryzen 5, 16 GB RAM, nVidia GTX 1050 or better, SSD 128 GB + HDD 500 GB 

Recommended  

Windows 11; 64 bit, Intel i7 or Ryzen 7, 32 - 64 GB RAM, NVIDIA RTX 5060 Ti 16 GB, SSD 2 TB (NVMe) 

Professional  

Windows 11; 64 bit, Intel i9 or Ryzen 9, 64 - 128 GB RAM, 2x NVIDIA RTX 5060 Ti 16 GB, SSD 4 TB (NVMe) 

Disclaimer: Intel Core 13th and 14th Gen K/KF/KS have serious issues with instability and we don't recommend it. 

 

1.2. Graphic card usage 

Using notebook PC: Power plan should be set to high performance 

In case of additional graphics card: Dedicate the use of graphics card to Cube-3d.  

Right click  on Cube-3d shortcut  -> Run with graphics processors  -> Change default graphics processorê  
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When cardõs control panel pops up, go to Manage 3D settings  -> Program settings . Check if Cube-3d is on the list of 

selected Program to customise. If not, click Add button and find Cube-3d. Click Add Selected Program  and close Control 

panel.  

 

1.3. Cube-3d modules 

Several modules of Cube-3d are available, subdivided as follows: 

Tool PHOTO SCANNER PRO 

3D Model from images/video Ṋ  Ṋ 

GCP Orientation Ṋ  Ṋ 

Classification Ṋ Ṋ Ṋ 

Point Cloud Registration  Ṋ Ṋ 

Mesh Calculation Ṋ Ṋ Ṋ 

Ortophoto Ṋ Ṋ Ṋ 

2Dviews Generation  Ṋ Ṋ 

CAD Ṋ Ṋ Ṋ 

Volume Calculation Ṋ Ṋ Ṋ 
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Profiles Calculation Ṋ Ṋ Ṋ 

Contour lines Ṋ Ṋ Ṋ 

Video Recording Ṋ Ṋ Ṋ 

 

The PHOTO module allows you to completely process photogrammetry data, from the images to a complete 3D model 

with analysis, The SCANNER module is designed to import, register and analyse point clouds from laser scanners. The 

functions presented within thi s manual are all available within the PRO version. Next to each section, you will find a legend 

representing the modules for which the described function is available.  

Legend : 

PH = PHOTO module 

S = SCANNER module  
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2. GUI (Graphical User Interface)  walkthrough  

2.1. Welcome screen  

Opening Cube-3d brings us to a welcome screen with a couple of options to start our project; New project , Open an 

existing project, or select from recent projects  list. Other buttons remain disabled as no data is loaded in the app. 

 

 

Graphical user interface of Cube-3d consists of four fundamental sections with tools, advanced options, guidelines and 

information for data processing:  

1. Toolbar  is the upper left part that provides us with all main options  

2. Working Panel  is located on the right side containing seven tabs, each giving us basic and advanced tab related 

tools. Tabs unlock as we move through processing to point cloud, modelling, Orthophoto, etc. Some menus, as 

well as some functions are locked due to either lack of data or because we tried to skip some of the processes. 

3. Live Command Window  is located on the lower left part, providing us with live results of running functions: 

coordinates of markerõs position, computed distances, etc. 

4. Viewer  is the central board for viewing images, and all of 2D or 3D data. 

 

2.2. Viewer and live command window 

Main Viewer screen and Live Command line provide and interactive graphical and numerical interfaces for you to control 

and work with models, results, pick points, monitor coordinates as you explore your 2D or 3D material. The easiest way to 

handle models in Cube-3d is using a mouse and its four operations. Left mouse click is, just like any other app, used for 

selecting (starting polygon selection). When selecting polygon, use left mouse button to determine its points and right 

mouse click to finish your selection. To rotate models, click and hold left mouse button. To zoom in or out use the scroll 

wheel. If you need to shift the selected angle of view at selected zoom, click scroller and use it like pan function. When 

viewing Orthophotos or Profiles use scroller to zoom and pan. 

4 

1 

3 

2 
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3. Preparation  of photogrammetric data ( PH) 

Prepare your project folder on your disk and copy your images of selected project from SD card into the folder. If your UAV 

supports telemetry, use that data. Depending on your UAV model, telemetry data are ascribed to images, or recorded into 

*.csv file.  

The .csv file must also be added alongside images and consists of further data: enabled, index, longitude, latitude, altitude, 

date, time, yaw, pitch, roll, x Sigma, y Sigma, z Sigma, p Sigma, blur, and file name. Organization of data must be known 

but is to be specified as you wish. See below an example of generic telemetry file (use this option if your UAV type is not 

listed). It is recommended you save your ground control point coordinates ( GCPs) .txt file into the same folder as your 

image files. GCP file should be organized in the following way: point name, x coordinate, y coordinate, z coordinate ð space 

delimited. Be advised, it is highly recommended to make some map of GCP/validation points locations especially when 

large datasets are in use. 

Example of GCP coordinate file: 

 

Example of csv telemetry file: 
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Example of .csv generic telemetry log file: 

 

 

3.1. Option settings  (PH, S) 

Start Cube-3d and set language. Click Options -> Application settings  and select language and units- You have to restart 

application to assign applied changes. If select Automatic machine deactivation,  after closing the software the machine 

will be automatically deactivated, letting the user to use the software a second computer without removing the license 

manually. 

You can also set the number of decimal places shown in CAD measurements, up to a maximum of 5. 

 

When imperial units are selected, you can further assign weather you want International foot  or US survey foot . You can 

select Other.  On the right, where by default is set 1.000000000000, type value of 1unit in meters.  

Next, click Bundle Adjustment .  
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There you can assign: 

Number of Maximum parallel threads depend on your computer CPU type. For default value Cube-3d checks number of 

available threads and directs them all. Decreasing threads is an option when RAM is insufficient to avoid plausible comp 

crash. It is imperative to keep sufficient level of RAM and processor. For example: if you have a good i7 processor with 4 

cores ð 8 threads and just 8GB of RAM we would advise you to lower the threads number to 4. This will avoid memory leaks 

during the processing. 

Number of Maximum detected features, default number is 40.000;  

Features correspond to so called tie points on each image further used for òsawingó them to strings and strings to block. 

Feature detection level defines robustness of the matching step. Level of detection is inversely proportional to reliability 

and smoothness of detected points ð features. Level of detection is also proportional to time of computation. Levels rise 

from Normal, High to Ultra. 

Click Reconstruction  to set Number of maximum parallel threads , where default value is 8. When all preferred values 

are assigned, click Ok to assign selected measures.  

 

 

To save the changes for Language and Units you have to restart application to assign applied changes.  
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Changes of Bundle adjustment and Reconstruction settings are confirmed with selecting OK button - You donõt need to 

restart application. 

Note, that, if selected language is other than English, furtherly named command buttons and functionalities will be 

translated to selected language and will therefore defer from presented screenshots. 

 

3.2. License details (PH, S) 

All cube-3d licenses are floating licenses. Just go under Help -> License and click on Deactivate machine. 

This will allow you to use the same license on another machine. Is possible to check also the active 

modules. 

In case you have a new code, click on Change license key. 
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4. Processing (PH) 

Aerotriangulation, Geo-referencing and Reconstruction 

This part of Cube-3d empowers you to import your own dataset(s) containing images and geospatial data to generate 

metric, geo-referenced point clouds that serve as a basis for further modelling and analysis. When using unmanned or 

manned aircraft for the resulting data are overlapping aerial images along with image positions (exif gps, rTK, PPK, etc.) 

and/or GCPs to further improve geospatial orientation of the model. Therefore, it is advised to utilise flight mission planning 

software/app compatible with your UAV ( pixhawk, GS Pro DJI, etc.). Flight path needs to be planned as to achieve image 

overlap that is paramount to successful matching and alignment of the images. Recommended overlap is 70% or more 

(For terrain with higher terrain difference increase it up to 80%).  

Another important parameter of mission planning is setting the right flying height . Its value depends on desired ground 

pixel size, resolution of used camera, and terrain characteristics. If your platform supports telemetry data, this is where it 

comes into play. Use it. To further improve geo-locating and referencing your project/model  it is recommended to use 

ground control points. They need to be distributed across the surveyed site properly as to provide adequate spatial 

reference (minimum 3 GCPs, recommended 9 GCPs per every 500m x 500m area/segment). GCPs can be measured manually 

using GNSS devices (or any other device with GPS/GNSS capabilities) and can be in the form of natural/manmade features 

(building corners, rocks, manholes, shafts, etc.) or in the form of ground control targets. You can find the video description 

for all the procedure in the following video:  

To recap: Place GCPs Ą Plan flight mission + UAV flight (capture images and positions) Ą Import to Cube-3d. 

 

4.1. Setting flying height  

To achieve great results, make sure you start with the correct settings right at the beginning. Higher overlap means more 

images and more images means longer processing time. The minimum overlap between images is 65% (front and side 

overlap). However in some cases (wide-angle cameras, high vegetation, uneven terrain, etc) it is safer to increase these 

values to 80%. Below are instructions on how to best prepare and set up your flight mission to get the best possible 

orthophoto with minimum processing time. In case you would like to  calculate volumes, as well, additional side images will 

have to be captured ð see the instructions for Volume calculations.  

Standard settings for any drone, any camera:  

¶ Camera angle nadir direction (vertically downward) - 90° angle  

¶ Flying height from 40 - 150 m AGL (above ground level) - Usually 80 m  

¶ Front Overlap (overlap in the flying way) 80%, Side overlap 75%.  

Most drones automatically geotag the images based on drone GPS (usual accuracy 1,5 m) and you can orientate the model 

in Cube-3d based on that telemetry data. If you would like to achieve survey-grade accuracy (up to 4 cm), donõt forget to 

set up GCPs before the flight and measure them with survey-grade RTK GNSS. In case you have a drone with RTK GPS with 

1 cm accuracy you can use that data to orientate the model accurately without employing any GCPs.  

Note: We always recommend using GCPs if the type of terrain allows for the placement. Cube-3d supports all combinations 

of geo-referencing data, including or excluding GPS inputs in the processing stage is also supported. Check the instructions 

hot set them correctly: GCP Setup  

Tips and Tricks:  

1. Start your mission from the highest point in relation to the terrain you are about to map. Most drones (DJI 

Phantom 4, Yuneec, DJI drones) fly missions in a single plane and donõt automatically adjust their flying height to 

https://d52dhomxeqj2r.cloudfront.net/Support/Products/Software/Cube-3d/Tutorial/Cube-3d_PerfectOrthophoto_ENG.pdf
https://d52dhomxeqj2r.cloudfront.net/Support/Products/Software/Cube-3d/Tutorial/Cube-3d_GCPSetup_ENG.pdf
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the terrain characteristics. This can result in an insufficient image overlap (less then 60%) when capturing higher 

terrain points, high buildings, high trees, etc. in case you start the mission from lower positions.  

a. Best practice: Drone mission 80m 80% overlap 65m 70% overlap 95m 90% overlap  

 

b. Wrong starting point:  

 

2. Lower flying height with better ground pixel resolution (GSD) does not always mean better results. In areas with 

high density of buildings, flying too low can result in the following:  

a. High buildings will not be ortho -projected in the digital orthophoto.  

 

b. Image stitching can be less than perfect if they are directly over a building.  
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To eliminate the over-the-building image stitching we advise you to have the whole building on a single image. First, 

perform your mission at 80 m AGL, then manually trigger a few nadir images from a higher AGL (120 m above the object, 

for example) to get the whole object in one image. That enables you to recalculate the area with - or/and around - the 

building . 

 

4.2. GCP setting up 

Ground control points orientate the model and improve the accuracy of calculated model. Minimum 

required number of GCPs to orientate the model is 3, however it is highly recommended you always use 

more than required. We advise you to set up a minimum of 10 GCPs per 10 acres (most common area size 

that can be mapped with a Drone on a single battery).  

Use recognised targets (1. Stonex AutoDetect Target, 2. Checkbox Target, 3. AprilTags, 4. Custom) as GCPs, 

place them on the ground before flight and measure them with a GPS (GNSS) or total station. 

 

Use the advanced automatic orientation in Cube-3d.  
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Note: in case you are not using Cube-3d ground control target template you can measure any characteristic 

point in the area of interest, such as manholes, curbs, road markings, etc. That still enables you to do the 

orientation in Cube-3d but in this case semi-automatic.  

Accuracy of the end model depends on:  

¶ Camera type  

¶ Flying height (image resolution)  

¶ Number of GCPs and correct setup  

Best practice GCP setup  

Square areas GCPs should be spread across the whole area as uniformly as possible and should not be 

placed to close to the border of the area of interest.  

 

In case of uneven (or rugged) terrain it is highly recommended to place GCPs on both lowest and highest 

points of your area of interest. 
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 To achieve survey-grade accuracy, place your GCPs 50-100 m apart. Higher density of GCPs also means 

higher accuracy of end results. 

 

 

Road/Railway example of GCP setup  

To achieve survey-grade accuracy (up to 4 cm) we advise to set up GCPS in pairs every 50 ς 100 m ς one to 

the left and one to the right of the object of interest (road, railway, river bank, etc). This will provide you 

with a stable and consistent accuracy across the whole area ς around the pairs as well as between them.  
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4.3. Uploading images with saved metadata (PH) 

Start Cube-3d, select the button New project  in the Viewer and select the project images in the folder. The same can be 

done via the Toolbar Images - > Load images.  

 

 

When images are uploaded, the telemetry importer window appears. For DJI drones, Yuneec drones and all other drones 

that write the GPS position of the images during flight use EXIF data.  

For drones with a separate log file, use one of the following options:  

¶ C-astral Bramor Ą *.csv 

¶ MaVinci Sirius Pro Ą *.csv dati Exif (DJI Phantom 4, Inspire 1, eBee, Falcon 8,..) 

¶ Other Ą *.csv 

When images are imported, their telemetry is read. This opens a page where you enter the coordinate system of the images 

and the project. If the images already have this information the software reads it automatically, otherwise you can set it 

manually. You can select the horizontal coordinate system, and also the vertical coordinate system. Then select whether 

the height is ellipsoid or geodetic.  

It is also possible to select previously created presets, changing from Custom to another system. 
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The telemetry will be read in automatically and a new window will open. The Telemetry window will open, presenting the 

imported data and their transformation into the project's coordinate system with their accuracy . You can manually set the 

accuracy and determine the Camera to GCP offset  and Flight Height . If you imported the wrong log file, click on 

Reimport , to re-import the telemetry data or/and close. Camera positions are displayed in the Viewer after the data has 

been imported and processed.  
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4.3.1. Uploading images with external telemetry (PH) 

If the images you upload do not have telemetry values saved in the metadata, you can upload an external file with this 

information. Select the pen icon. 

  

First set the data delimiter. Click where Semi-column [;] is displayed and select the delimiter sign. Now you have to assign 

the attributes of your log file to each column. Click on a tab at the top of each column, where none is displayed. Scroll 

down the list and click on the desired attribute to assign each column to the specified attribute . 
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See below for an example of what the file should look like to import telemetry data . 

 

It is then possible to select the coordinate systems of the images and the project. To search for the desired reference system 

or geoid, click on the datum name and type in the name or keywords for the search. Once all the data have been selected, 

click on Import . 

The telemetry will be read in automatically and a new window will open. The Telemetry window will open, presenting the 

imported data and their transformation into the project's coordinate system with their accuracy . You can manually set the 

accuracy and determine the Camera to GCP offset  and Flight Height . If you imported the wrong log file, click on 

Reimport , to re-import the telemetry data or/and close. Camera positions are displayed in the Viewer after the data has 

been imported and processed.  
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4.3.2. Commands for images (PH) 

At the top left of the Viewer, you will see four buttons, Images, Maps, Telemetry and Sparse point cloud  to view the 

data in your preferred mode. At this stage, Sparse point cloud is not available. When in telemetry mode, three buttons 

appear in the top right -hand corner. 

The third button is for displaying image names. By default, all imported images are selected the number of images selected 

from those available is shown in the work panel. Use the Deselect button to exclude any number of images from the group 

setting. Use the left mouse button to draw the polygon surrounding the desired cameras. Close the polygon and confirm 

your selection with the right mouse button. The deselected images will change colour from blue to grey and in the list of 

images in the working panel, the deselected images will be unselected. If you want to include some of the deselected ones, 

click on the Select button to reselect them, or dock them in the image list. This has intrinsic value in two cases: 

¶ When a dataset of more than 1000 images is processed, probably the most efficient way would be to process 

them by parts; 

¶ You can easily de-select images that are not important for your project and would only increase the processing 

time of your project - panoramic images, images while lifting the drone to the exact height, etc . 

4.3.3. Advanced Explanation on Coordinate Systems (PH, S) 

When importing image telemetry data or ground control points, the data and project coordinate system must be selected. 

When assigning the preferred project coordinate system, as described in 4.3.1, you may be interested in the data displayed 

along the selected coordinate systems. 

 

In the window you can select presets created by the software for different regions, load presets in PRJ/WKT formats or set 

up a custom system.  

 

If you are working in custom mode, you can select either a horizontal or vertical system for your system. Click on the name 

and type in the system name or keywords to search for it. 

Once selected, click select. The custom datasets created can be saved in different formats (WKT, PRJ, JSON) by clicking on 

the icon at the bottom right of the main software screen . 
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4.4. Bundle adjustment (PH) 

If you have camera calibration parameters, click  and load camera parameters. Such data significantly improves the 

speed of the process of bundle adjustment and should be imported if available. For most popular drones (DJI Phantom 4, 

4 PRO, Mavic, ...) the predefined parameters are already integrated in the software and you donõt need to import it 

additionally . In case you are using other cameras, we advise you to calibrate your camera on your fist project and use those 

parameters for future projects. Check out chapter: 4.3.4.3 Export camera calibration for detailed instructions.  

Above Bundle Adjustment  button number of all images  is presented as a number of used images . Press Bundle 

Adjustment  to calculate parameters of camera orientations. 

 

 

You need to select the Mode of adjustment:  

- Global  is faster method suitable for larger datasets ð use it for default setting. In case you will not be satisfied 

with the number of matched images repeat the Bundle Adjustment calculation with Incremental approach.  

- Incremental  is slower but more stable ð suitable for project where image texture or overlap isnõt the best: High 

vegetation, bad overlap between images, blurry imagesê We advise you to use incremental approach for data 

sets up to 500 images (because of the processing timeê) 

- Hybrid  is combination of global and incremental mode. It gives the best result using characteristics of both 

modes, but is also the slowest. 

Click Show more , to select:  

- Maximum CPU workers : The number of CPUs working together. 

- Maximum detected features : The maximum number of features that will be extracted from the images. 

- Feature detection level : The level of feature detection: Normal, High or Extreme. 

- Pair selection : How to select and pair images: 

o Telemetry: look at the drone's telemetry. 

o Generic: try to choose images at random and try to pair them. 
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o Sequential: use in case of images extracted from video. Select images sequentially. 

o All: Try to use all the previous methods. 

- Use telemetry data : if you have drone telemetry you can orient the cloud with it.  

Click OK to start Bundle adjustment. The processing time could be between a couple of minutes and up to several hours. 

It depends on the number of images and your CPU specifications (number of coresê) 

Note: Try to save your project after every operation (Bundle Adjustment, Orientation and Reconstruction). It can be done 

through Toolbar Project > Save project . The latest version also has autosave , which makes that for you. 

All images must be imported from a single folder to be processed as one project. Some of the drones start to write images 

in a second folder after 1000 created images and start once again with the image name 001.jpg (Phantom 4 Pro). In this 

case rename the images in second folder and copy all in one folder. 

Once project is bundle adjusted, you can observe several functions in the viewer. As before, you can watch images , or click 

telemetry , to observe location and orientation (external orientation) of images. Toggle text , to view or not image names. 

 

Click sparse point cloud  to observe sparse point cloud beneath telemetry data. There, you can toggle text , select or 

deselect desired camera positions or click convert to point cloud  that shifts your position in the working panel from 

Images to point cloud.  

 

4.4.1. Bundle Adjustment troubleshooting  

If bundle adjusted set of images is beneath your expectations, here are some guidance, that might help. 

In case, that matches were found on only half of the selected images (probably due to insufficient overlap, bad texture on 

images, high vegetation, images of water areas that are blurry) you may get better results by: 

- recomputed Bundle Adjustment using Incremental mode. If results arenõt better, proceed; 

- go to 3Dproject folder, and inside the folder with images manually delete folder named òFeaturesó. Then increase 

Number of maximum detected features to 80.000 in Cube-3d -> Options. Results should be better. 

If the results are still insufficient: repeat the step 2. and increase also Feature detection level from Normal too High or Ultra. 
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After computation, set all changed parameters back to default, because made changes increase processing time and are 

unnecessary for standard datasets. 

Default values of Number of maximum detection features is 40.000. Feature detection level is, by default set to Normal. 

4.5. Orientation  (geo-referencing) (PH) 

To geo-reference a project, proceed with Orientation . Three options are available depending on your data type. 

4.5.1. Orientate with telemetry data 

In case of available and imported telemetry data, you can orientate images using just telemetry recordings, although it is 

recommended to use GCPs to achieve better accuracy. Remember, in the process of Bundle adjustment you selected 

weather you wish to orientate images or not.  

 

To proceed, click Orientate with telemetry data  and follow the pop -up wizard. First you inspect location of images in 

assigned coordinate system. Some rows might be seen in grey colour as imageõs telemetry has error. To proceed, click 

Next . 

file:///C:/Users/ssangalli/Downloads/3Dsurvey%20User%20manual%20v2.13.(2).docx%23_Bundle_adjustment
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Orientation summary  window presents residuals of adjusted camera positions on all three axis and its spatial value. Click 

Finish to complete orientation. If some images have errors in telemetry, they appear as unregistered in the List of images 

in Working panel . 

 

4.5.2. Orientate with GCP 

In most cases, especially when telemetry data cannot be measured, or it isnõt accurate enough (most UAVs caries GPS 

antenna with 1.5m accuracy), block of images is orientated using ground control points (GCPs). Position of GCPs are 

measured using GNSS services or by total stations.  

 

To proceed, click Orientate with GCP and follow the Orientation pop -up wizard. First, select ground control points  (*.txt) 

file and click import . Define the file delimiter. You can change the type of data to be read in each field, and you can ignore 

some fields by putting NONE on the column. Finally, choose the reference system. 
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In the next screen you can define the type of target used, its size and the method of use of the control point. Click on the 

field after the points name and select whether it is a ground control point (GCP) or a validation point : 

¶ GCP - its reference coordinates are used in the orientation adjustment, 

¶ Validation point ð excluded from orientation adjustment and used for quality assessment at the end of the process. 

In case you select the wrong coordinate system by importing the images into project, be reminded that you cannot change 

project coordinate system in this step. If you would like to correct this you need to start from the beginning (New project, 

ê) or use the second option ð select: Local coordinate system. Further information about coordinate systems can be found 

in chapter Bundle Adjustment troubleshooting. 
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If you continue, you will end up in the screen for selecting control points within the images.  

 

4.5.3. Automatic orientation  

On the left of the pop -up window, select image  with GCP. Use mouse scroller to zoom in or out. For automatic orientation 

a minimum of 3 GCPs need to be manually marked. Mark  GCP with a right mouse click . Marked position is coloured in 

orange and ascribed a ôõ?õõ as its name is not defined.  

GCP Map 

Expected errors 
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Continue by selecting additional two  GCPs from other segments of your project area. When you select the third ground 

control point the automatic recognition for all other GCPs will start. Three marked GCPs remain orange coloured while 

automatically found GCPs are now coloured green and the names of all GCPs are identified. 

 

If you mismark the position of the ground control point, click Clear all marks button and reselect. Otherwise, click Confirm 

unknown marks. A useful tool for checking the appropriation of GCPs are their residuals. If displacements of selected points 

are high, you should check if you forgot to survey one of them (their position is missing in the file). Described method of 

Automatic orientation  as furtherly described Troubleshooting with orientation  in chapter Troubleshooting with orientation. 

 

4.5.4. Semiautomatic orientation  

Use GCP Map and select first the name of the ground control point on GCP map with left mouse click  (for example 2009) 

and mark  its position on image  with left mouse click.  Marked position is coloured blue, and its id appears.  

If you mismark the position, click Clear mark button and reselect. Clear all marks button clears all selected markers. 

http://www.3dsurvey.si/support/tutorials/3d-model-orientation-with-exifgps-and-ground-control-points-gcp
http://www.3dsurvey.si/support/tutorials/gcp-orientation-troubleshooting
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Select two more  GCPs with a left mouse click (same as above). When you select the third ground control point the 

automatic recognition for all other GCPs will start. GCP are now coloured green and the names of all GCPs identified. 

 

 

In the lower right corner appears the residuals  of marked points. Residuals should be within 1m. Check if the automatic 

positions are calculated correctly - GCPs need to be coloured green. If not, correct them with manual selection. First, select 

the name of GCP on GCP map, then show the exact position of GCP map on an image. Use left mouse click. 
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In case you are using STONEX GCP targets  (black dot on white plate) be sure to select the ôõDetect targetsõõ and set the 

correct diameter for the black dot. The default value for diameter is 0,27m (standard Cube-3d target). In case you are using 

some detail points for orientation as manholes, road marks, building  cornersê deselect ôõDetect targetsõõ click next  to 

continue with orientation .  

 

In the next step, we can see automatic recognition of ground control points (in case of Cube-3d targets). If the GCP is not 

recognised on a specific image, it is eliminated and coloured red. If you want to include this GCP into orientation, just 

double click the image and the red overlay will disappear. Several images can be marked or unmarked by ticking them in 

their upper left corner, where unticked square appears. Use Ctrl + A shortcut to select all target windows at once. You can 

also correct/realign the automatic measurement - left mouse click and move the centre of GCP to the green cross. Same 

approach can be used to correct the positions of GCPs that have been automatically detected but not measured perfectly 

because of the bad conditions during data acquisition.  

 

Faster approach for centring target is provided by the right mouse click. Put the mouse in the centre of the target and right  

mouse click for centration. Use mouse wheel or slide bar below to zoom in or out, which works for all target windows to 

realign easier.  

If you are using the same dataset in numerous computations/projects it can be useful to export GCP image positions of 

centred targets. Click tooth wheel button  in the upper right corner and click export . In case if you calculate the same 

project again next time you donõt need to select and correct the GCP targets once again but just import the saved file and 

go to next step. 
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Click Next, to observe orientationõs accuracy. 

Orientation summary displays GCP errors ð a sum of photogrammetric measurements and total station /GPS measurements. 

Check GCPs accuracy by observing  their residuals . If residuals show high displacements of certain GCPs, go and recheck 

them. Click back  button on the upper left corner and repeat the marking process. Click Finish  when satisfied. Remember 

to save the project. 

 

To check for independent accuracy quality, GCPs can be marked as Validation points that provide independent values to 

compare against GCP values. Points defined as Validation points get coloured grey. 



 

Stonex Cube -3d ð User Manual    34 

 

In the orientation summary, you can observe adjusted accuracy presented with residuals. As four points are used as control 

points, orientation is computed based only on selected GCPs. As described above, residuals need to be low. Impact of their 

size can be observed on residuals of control points. In case of high values markings need to be corrected. 

 

4.5.5. Troubleshooting with orientation  

In case if automatically selected point markers mismatch - residuals show large coordinate differences, that exceed 1m 

limitation for presentable final centring, as presented below - you should click clear all marks  and proceed semiautomatic 

orientation, as described above.  Keep in mind that selected points need to be observed ð have observed coordinates 

written in *.txt . If at the beginning of the orientation, at least one of selected markers is declared as control point, residuals 

will show misplacements.  

If you would like to continue with the standard workflow, continue with the Reconstruction.  

 

4.5.6. Orientation of unknown dataset  

Sometimes you need to process dataset of one of your co-workers. You werenõt present during field work and you do not 

have any map of positions of GCPs. There are several ways to proceed: 

¶ Use Automatic orientation method  

¶ Select all GCPs as validation points and use Semiautomatic orientation method  for GCPs you are shore of its 

position. Observe residuals from the list, and if for some GCP values are high, select it from the list or click on it in 

the map and click clear mark . It is time consuming process especially when processing large datasets. It is highly 

recommended to make and archive some map of GCP / validation point locations.  

 

 

 

file:///C:/Users/ssangalli/Downloads/3Dsurvey%20User%20manual%20v2.13.(2).docx%23_4.3.3.2.1_Automatic_Orientation
file:///C:/Users/ssangalli/Downloads/3Dsurvey%20User%20manual%20v2.13.(2).docx%23_4.3.3.2.1_Automatic_Orientation
file:///C:/Users/ssangalli/Downloads/3Dsurvey%20User%20manual%20v2.13.(2).docx%23_4.3.3.2.2_Semiautomatic_orientation
file:///C:/Users/ssangalli/Downloads/3Dsurvey%20User%20manual%20v2.13.(2).docx%23_4.3.3.2.2_Semiautomatic_orientation
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4.6. Advanced functionalities (PH) 

4.6.1. Export camera parameters and undistorted images 

If you would like to import results of Bundle Adjustment in any other photogrammetric software, you need to export camera 

parameters and undistorted images. Click Data , chose export camera parameters . Type preferred name of exported 

document or chose predetermined one and confirm.  

 

4.6.2. Export undistorted images 

Click Data  and chose export undistorted images . In the popup window assign path of directory and type in its name.  
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4.7. Reconstruction (PH) 

When you are finished with orientation wizard the main window will appear. Next step is Reconstruction of dense point 

cloud.  In the dialog box, you can set the cloud reconstruction parameters, as well as the subsequent steps for creating 

photogrammetric products such as 3D Mesh and True Orthophoto. For more details on these products, refer to the 

dedicated sections of the manual. 

 

 

Click OK to start reconstruction. 

Below, each reconstruction parameter is described for more information.  

Reconstruction level  ð there are 4 levels of reconstruction:  

¶ Low, 

¶ Medium, 

¶ High, 

¶ Extreme. 

As the reconstruction is in progress, the Point cloud tab unlocks in Working panel. In the Viewer, the progress bar displays 

the stage of completed processing. The predicted processing time is realistic after 7% of the process is computed. 



 

Stonex Cube -3d ð User Manual    37 

 

 

Reconstruction advances 

As described in Option settings  desired images can be chosen to reconstruct point cloud from.  When all images are being 

orientated, point cloud can be reconstructed from only one selected image. Although you chose only one image, app runs 

reconstruction with all of overlapping images, w ith same detail of surface. Select preferred images and run reconstruction . 

You can use select or deselect button or manually deselect images from the image list. Further assign desired level of 

reconstruction, number of overlapping images and possibility of optimization.  

This function allows you to process the dense reconstruction for one project in two pairs (1st half and 2nd half) or calculate 

the dense reconstruction with a different level ð for example: centered area with Extreme level, less important area on High 

or Medium level.  

To see the effect, we selected point cloud (coloured purple) reconstructed from one selected image with its overlapping 

images selected amongst point cloud reconstructed from entire batch of images. Although selected image was from the 

first row of images, about 700.000 points were reconstructed. 
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5. Point clouds registration ( S) 

5.1. Manual registration (S) 

Import the point clouds you wish to register. Click on Point Cloud, then click on Load. Both point clouds will be 

displayed in the viewing area. Once loaded, click Manual Registration in the tools area. 

 

In the registration window, the two point clouds will be displayed side by side in two windows. On the left the one to 

be recorded, on the right the reference one. You can import a GCP co-ordinate file by clicking on the folder icon of 

both point clouds . 

 

Under 'options' it is possible to switch between colour and other colour displays such as intensity or height scales, and 

it is also possible to increase the size of the dots. 
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You can create matches manually if no GCPs have been collected or if you wish to add more. In the registration window, 

double-click on a point cloud to enlarge it. Navigate to a recognisable point in both point clouds, then click to create 

a new match. Two matching points must have the same name to be connected correctly. 

You can also fix the Z-axis (fix z-axis) if the scans have the same levelling or fix the scale (fix scale). 

In the central part you can see a preview of the errors. By marking Generate report you can save a report file with the 

residues. You can delete a point by clicking on the 'x' next to it. When finished, click Save. 
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Here is an example of a registration report. The average errors and residuals for each match are shown as 3D error and 

error for each coordinate. 

 

5.2. Automatic registration (ICP) (S) 

Right-click on the name of the point cloud whose registration you wish to refine. The ICP algorithm is used at this stage. 

You can also click on the button at the bottom right of the tool section to activate automatic registration . 

 

 

Select the point cloud you wish to record and the reference cloud, then also select an ICP mode from Fast, Normal and 

Accurate. 
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A report can be generated, as for manual recording, by ticking the corresponding option.  

 

 

Here is an example of an ICP report 
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6. Point cloud manipulation  (PH, S) 

The calculated point cloud will appear in Point Cloud tab. To manipulate the point cloud: use left mouse click  to rate point 

cloud, scroll  to zoom in or out, click and hold the mouse scroller  to pan the model.  

 

 

Point Cloud includes points from surface, buildings, vegetation and other objects. To generate a digital Orthophoto those 

obstructions need to be eliminated (select and delete) as to get a clear digital terrain model that serves as a basis for 

Orthophoto g eneration.  
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6.1. Point rendering (PH, S) 

 

Use the Point render size  bar  to increase or decrease the points of Point Cloud. 

 

 

6.2. Point snapping (PH, S) 

Use the Point snapping  tool to inspect the 3D coordinates of the point cloud. The x, y, z values are presented in the live 

command window (lower right corner).  
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6.3. Cube-3d viewer (PH, S) 

Use Reset view  to set the default view. 

 

 

If you would like to view PC or DSM from nadir projection, click  Top down  button. Model can now be rotated only around 

z-axis. The button is on as long as you do not switch it OFF. 

 

 

If you would like to view the point cloud in orthogonal projection, you need to click Ortho mode  button. Enabling the 

function results in the button colouring blue. To rotate around all axes, disable the Orto mode by selecting the function 

one more time. 

 

 

If you would like to capture short movies from your 3D model with an external software, you can use Free flight  function 

and smoothly fly around 3D model and objects. Use: left mouse click +  keyboard . A to move left, D to move right, W to 

move forward, S to move backward, F to zoom in, R to zoom out, V to zoom in centre. Scroll  to set vertical angle of view. 

To speed up the flaying press +, to reduce speed press -. 
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IF you wish to see PC and DSM at the same time, click Point cloud & DSM  button. You can use this function in CAD tab, 

Point Cloud tab or DSM tab. This is a useful tool when you are working with Point Picking function. 

 

 

If you wish to see positions of cameras above the point cloud ð reconstructed terrain, click Cameras. You can use this 

function in CAD, Point Cloud or DSM tab.  

 

 

Bounding Box ð It is a useful tool for two reasons. 

First, move sections freely left, right, up or down and the tool lets you easily inspect the data inside the box whilst ignor ing 

everything outside your box selection. 

Second, sliding 2 opposite Bounding Box panes together gives you a 3D profile of the surface model.  

Third, click and drag on any of the rims of Bounding Box and rotate bounding box around point cloud centre. To move 

through the 3D model press CTRL and left-click on the Bounding Box pane and you will be able to slide it in any direction 

and explore all the sections on the fly. Turning on the Height map displays the height differences even more clearly. 

Use Bounding box in either point cloud tab or DSM tab.  

It is possible to inspect the differences between several point clouds or surfaces, of course. For example, loading two-point 

clouds from the same area but measured at a different time and using Bounding Box will clearly show the difference. Apply 

different colours to surfaces for even more impressive results. 
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IF you wish to record desired parts of computed project and highlight significant details, click Recorder button. You can 

use this function in CAD tab, Point Cloud tab or DSM tab. This is a useful tool when you need to make quick presentation 

of project and made calculations. 

 

 

6.4. Point selection (PH, S) 

Click Select button and draw polygon around surveyed area using left mouse click . Finish the selection with right mouse 

click.  Selected points will be coloured. 

Use the Deselection function to ignore interested points from selection. Left mouse click to select, with right mouse click 

to finish selection. Use ESC on keyboard to cancel selection or click clear button. 

 

If you click on the triangle, it will also be possible to make the selection based on CAD data or by selecting a colour from 

the cloud. 

 

Selecting a colour will open an interactive window giving a preview of the selected colour and you can change the tolerance 

parameter to select more or fewer points of similar colour. Clicking OK will select the corresponding points and you can 

decide what to do with this selection . 
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6.5. Deleting points (PH, S) 

To delete points, you need to select them first.  

 

Delete selected points either by clicking Delete selected  button or use delete button on keyboard. Use Delete other  

function to delete everything that is not selected.  Use Undo or Redo function in case you change your mind. 

 

6.6. Manipulate points  (PH, S) 

Popup Manipulate points  enables you to set height, increase height or compute average height of selected area. Select 

desired area and click set height . Type desired new height  and click OK. The selected points are moved accordingly. 
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In case you would like to lower or raise the selected points use increase height function and type the desired value. For 

example, if you would like to lower the selected points for 0.5 meters type -0.5 m. If you would like to raise the selected 

point to specific value, type for example 1.5m and click OK. 

 

You can also compute the average height  of selected points. Firstly, select the area of interest, go to Manipulate points 

and click Average height. 
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6.7. Calculating profile (PH, S) 

It is often required, especially on construction sites, to present profiles. Open Point cloud tab and click Calculate profile . 

Set the parameters in the pop-up: 

Consider point within distance 0.15 by default ð distance of buffer zone for snapping longitudinal profile to PC,  

Approximate segment length 0.15 by default ð approximate stationary distance of longitudinal profile,  

Calculate transverse profiles disabled by default ð to set computation of transverse profiles,  

Distance between transverse profiles 10 by default ð stationary distance on longitudinal profile to compute transverse 

profiles, 

Length of transverse profile on each side 10 by default ð width of either flank of transverse profile.  

 

6.7.1. Longitudinal profile   

To compute longitudinal profile, Calculate transverse profiles  must be disabled . Click Select profile definition line  to 

define profile.  
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Left clicking the mouse, draw polygon , that defines longitudinal profile, ending it with a right mouse click.  

 

 

Calculated profile is displayed on the Point cloud in both 2D and 3D or on the mesh (purple line). 

 

Calculated profile, presented on orthophoto (green line)  






















































































































































